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s anyone who manages project-related resources,
budgets and timelines within an organization can likely

attest, predicting the final cost of a project-in-progress can feel
as elusive as trying to catch lightning in a bottle – especially
where employees’ time is concerned.

It’s a challenge that David Ducolon, program manager for the
Microsoft Office Project software application set, hears
repeatedly in his visits with Microsoft customer representatives
who oversee resource management and time tracking. It’s also a
key focus area for improving the accuracy, flexibility and overall
usability of this software within the upcoming Microsoft Office
2007 information worker productivity suite set for general
availability starting later this year.

MPA asked Ducolon for more details about the software’s current
and future capabilities in the areas of resource management and
timesheet administration.

MPA: What do enterprise project managers and
leaders of project-driven organizations say are their
biggest challenges with regard to managing resources
and timesheets?

Ducolon: Within resource management,
people say they want to be able to track all of
the work and all of the time that their
resources are busy doing things, in order to
have the clearest picture of their organization’s
capacity to do business. This requires better
methods of capturing the data, mining it to
extract the most relevant details about team
members’ progress toward completing their projects, then
applying that intelligence toward process improvement. A
common obstacle to achieving total success in those areas is that
you’re dealing with people, and people usually don’t like their
time to be scrutinized down to every 5 minutes or even 15
minutes – it just goes against human nature and human desire
to be exposed to that level of scrutiny. But if you’re unable to
capture what every person is doing for every minute of their
working day, then you won’t be able to determine the ongoing
cost of any given project.

Also, while it may be relatively easy to capture the time they
spend working directly on a project, a lot of organizations
struggle to measure the time involved in people’s other
miscellaneous tasks or duties. Those things are often hidden
from view. Without the ability to get that information from the
employees, managers are neither able to assess what their
employees’ total capacity or abilities are, nor what the total cost
to their project is of having someone perform those tasks which
usually are a cost of doing the business of project work.

In terms of capturing resource costs through the timesheet,
customers have competing needs. Project managers want to
know what is it going to cost to finish the project, whereas the
project management office wants to know what is the project
cost to date. While the latter number is easy to get, the former
is less of a firm number that’s driven more by the projected
efficiency of your project team members going forward.
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“Microsoft recognizes MPA as the leading industry
association helping project managers and organizations
get the maximum value out of Microsoft Office Project.
With its different avenues to interact and network and
resources on Microsoft Office Project, MPA is playing a
pivotal role in helping project managers and organizations
learn from each other and maximize the success of their
projects using Project. We strongly believe that any
individual managing projects would benefit immensely
from being part of this association.”

Michael Angiulo, General Manager
Microsoft® Office Project, Microsoft Corporation

n the Project Management universe, we
get very caught up in words like
“resources”, “milestones” and “next

steps”. And even when we step outside our
professional selves, we don’t lose the ties to
this thinking. We always stay connected to
our project-oriented selves.

Well, it’s time to change. Yes, I know we all love what we do,
headaches and all included. But we’re not leaving, just
“refreshing”. We are disconnecting on our downtime, so that we
are better when we are working. A chance to realign and clear
our heads, can go a long way personally and professionally. I
grant you, there is a blend, a best of both worlds approach, but
this moderation can be difficult to achieve. As solution-oriented
professionals, moderation can seem limiting or incomplete. We
say, “Do more, see more results.” But, this may not be so.

When we do manage to step-away from our project selves, we
somehow never leave the jargon ties behind. However, we can
implement some minor language adjustments that will help us
“find the middle”. Here are some suggestions.

First, while time is a resource, recognize it is also a gift.
Appreciate the fact we can use it and then, use it well. Some
projects may need more of this “resource”, but there may be a
reason. Limit your time and frustration about it. Understand the
reason, acknowledge it and move on. More importantly, your
own time is for you. It has no criteria to meet other than your
own needs. 

Second, “milestones” are achievements. They are successes,
mini-celebrations along the way. Was your child’s mid-term
report card a milestone or a great accomplishment? A short-term
goal or a goal in and of itself? Be sure to see the difference and
celebrate the attainment genuinely.

Third, there are always “next steps”. If they were not there,
likely, we would not be here either. So rather than the never
ending “to do” list, our next steps are how we move from here
to there. Usually forward, occasionally misguided, but always
moving. And it is in this journey that we find the ability to be
ourselves. Yes, even our project management oriented selves. 

So, be better at being yourself by adding new dimensions to the
definitions you so strongly embrace as a professional. You will
enjoy the improved “scope”.

Best Regards,

Beth A. Swartz
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MPA: What effects can befall these organizations when
their resource management and timesheet
administration are less than optimal?

Ducolon: If you don’t know precisely what a person is doing
day to day, that tells you that you don’t know what they are
capable of doing. In that case, you cannot plan your business.
You are making guesses at your organization’s capacity to do
work and to complete it within a certain time frame – which is
the essence of effective project management.

The way that businesses typically are organized, timesheets and
resource management are treated as very separate disciplines.
Thus, many businesses are not looking at these two together. In
fact you cannot have a working vision of 100 percent of your
resources capacity to do work, without being able to capture all
of their activities, which requires the use of a timesheet.

MPA: What specific tools and capabilities are currently
offered in the Microsoft Office Enterprise Project
Management (EPM) Solution to help customers
optimize resource management and timesheet
processes?

Ducolon: Microsoft Office Project Server currently enables
employees to capture their project tasks and related assignments
as direct input to their timesheet. Also, Office Project Server
enables users to create new tasks without management input,
and also to track so-called called administrative projects or tasks
in order to capture all of the person’s work time. For instance, in
an eight-hour day, you might have six productive hours on your
project tasks, but you also need to be able to report those two
additional hours. Microsoft Project users can capture that time
by creating a new task in Project. The project manager can then
get involved to discuss with the employee where that time might
be more appropriately accounted for, if it doesn’t belong on the
project. Those two capabilities together enable team members to
enter all of their work into the system so the resource manager
and the project management office are able to view and
categorize all of the time properly – how much is project-related
work and how much represents other business-required work.

MPA: What types of new and enhanced resource
management/timesheet capabilities can customers
expect to see in the upcoming Microsoft Office Project
2007 release?

Ducolon: What we are doing in Office 2007 is to extend our
functionality in both resource management and timesheets to
embrace work entries that are less structured, or that represent
more of a non-firm time commitment. In resource management,
we will enable customers to plan at the FTE level what their

Managing Resources and Timesheets

resource needs are on a given project and adjoin that
information to the project. For instance, a project manager will
be able go into Microsoft Project and say: “I need one database
administrator and two security experts and four coders; and the
coders I need to have at three-quarter FTE and only for the
middle phase of the overall project.” By estimating the needs for
the project in this way, the resource manager can more
accurately assess the pipeline of available resource needs. These
enhancements in the next release of Microsoft Project will help
customers better plan how much work they can support going
forward. Therefore, they will be less likely to over-assign
resources, which should increase their ability to deliver the
projects on time and result in better overall productivity for the
business with less loss of money.

To help customers take that data and use it in the best way, we’ve
also tied together the resource availability and resource
assignment pages within the next release of Microsoft Office
Project.  Users will now be able to select a set of employees and
look at their availability to see how these resources stack up.
Whether they’re looking to maximize utilization or find a
resource to fit a certain opening, managers will be able to look
at this information in a graph and deselect the resources that
don’t meet their needs. With the resources that are left in the
selection set, a manager can look at their current assignments
and narrow the list further based on which resources have the
availability to take on a new assignment, and compare those
people side-by-side. This will give a manager 100 percent
insight to be able to say, “I know that resource is available and
has the capacity to do this work.”

MPA: What can customers start doing now to prepare
for implementing Microsoft Office Project 2007 so
they get the most benefit from its new capabilities?

Ducolon: They can sign up to receive the latest public beta
version of this software, which we released in May, at the
Microsoft Office System 2007 preview site
(http://www.microsoft.com/office/preview/default.mspx).
Microsoft also has published a set of three DVDs encompassing
more than 110 hours of keynote presentations, breakout
sessions and other highlights from the 2006 Microsoft Office
Project Conference in Seattle, where I and many other speakers,
extensively outlined the next version of Microsoft Project.
Everyone who attended the conference in January will receive
these DVDs.  All others can order copies on the event Web site
(http:www.msprojectconference.com).

By taking a deeper dive into the upcoming capabilities now,
organizations will gain a much better idea of which specific
process changes they might need to prepare for when Office
2007 reaches general availability in the next several months.

Continued from page one
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About this Article

ecently, Microsoft acquired a product called UMT.  The
product is now called Microsoft Office Project Portfolio
Server 2007.  More information on the specifics of this

product will be forthcoming.  This article will will look at the
ever-maturing Project Management space and delve into a
relatively new market space called Program and Portfolio
Management (most commonly referred to as PPfM).

The Beginning: Enterprise Project Management

Not too long ago, there was a leap forward in the Project
Management tools space, creating a new market called
Enterprise Project Management (or EPM).  This market was in
large part, defined by the release of the Microsoft Project Server
platform.

Using EPM, Project Managers are still managing project
schedules, tracking critical path activities and managing
milestones.  These Project Management tasks are certainly not
part of a common vernacular in which all members of a project
team may be accustomed to.  On the other hand, we are hard
pressed to find anyone that does not know what an issue, risk or
document is.  Further to that, we all understand the concept of
collaborative teams, whether technology is an integral part of
that collaboration or not.  EPM brings us one holistic
environment to manage and maintain our projects and
individual work deliverables.

Pcubed (www.pcubed.com) specializes in EPM, server-
based solutions, software implementation and technical
support. Drawing on vast customer experience and
expertise, Pcubed Perspective provides a blend of
strategic and technical content, with a varied look at how
Microsoft Project is being utilized within the marketplace.

Pcubed Perspective

R

Program Management – Or “EPM+”

Armed with an EPM solution to manage our projects in a
common and integrated way, we can now take a step back and
get smarter at how we select and approve our projects in the first
place and organize how we manage and maintain our projects in
a more substantial way.

The first step we can take is look at all the projects that are in
play and determine how they fit into the overall delivery of an
end product or set of deliverables.  This in and of itself can be a
very difficult task.  Take for example an IT organization, who
manages projects based on lifecycle delivery processes, having to
couple their project schedules with the facilities department,
who runs their projects based on construction delivery
methodologies.

Therefore, for us to manage a truly integrated set of projects as
a program, we not only need integrated plans, but a more
efficient way of identifying the key areas, such as phases, gates
or milestones where projects tie together. 

Today’s EPM tools – and certainly Microsoft Project Server 
2003 – can provide the capability to tightly integrate project
schedules while providing flexibility on the overall methodology
being used.  By way of web-based reporting our Managers 
and Executives can look at resource utilization and overall
project health with a bird’s-eye view of the entire program,
without necessarily having to know every project that makes up
the program.

An Introduction to Portfolio Management System
Bill Raymond, Microsoft Project MVP (Member, Arlington, MA)

Figure 1: In today’s EPM environment, project schedules and collaborative
environments are maintained to meet a set of end deliverables.  Microsoft

Project Server and Microsoft SharePoint are the key elements of the
Microsoft EPM environment.

EPM - Strategic Move, Tactical Importance

As an organization, we must take Project Management maturity,
organizational effectiveness and, cultural adoption into
consideration when considering an EPM solution.  Therefore,
applying the concepts and implementing supporting software
constitutes EPM being a strategic direction for any organization.

Once we bring these EPM efforts into play and begin using the
methods and software to implement projects, we are managing
the tactical delivery of our projects.  In other words, we have
approved projects, they must be managed and whole teams
must collaborate to deliver on the project’s promises and we
need a tool to track all of this for us.

Figure 2: When project(s) are approved and a team has been selected,
people will collaborate on their project within the EPM environment. We

have strategically provided a platform for project teams to tactically
manage their work to deliver an end product.

Continued on page five
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Introducing Program and Portfolio Management

Having brought ourselves to a point where we can manage our
projects and work with cross-functional teams that are all
marching to one goal, we can ask the next question: “What’s Next?”

We are now in a great position to move into the Program and
Portfolio Management (or PPfM) space.  Here, we look at our
overall initiatives, revenue goals, funding outlook, resource
availability and so on.  This will drive us in a direction of asking
– and answering – a critical question: “Are we doing the right
work?”.

The portfolio can analyze the current needs of your organization
against the value of selected projects.  Organizationally, we can
put metrics around projects and map them against strategic
alignment, value, regulatory mandates and other key drivers that
help us select the right work, instead of the work that will not
improve our business.

From an ongoing portfolio management perspective, we can
continually track the budgets, shifts in organizational goals and
risks against current or future projects and programs.  Tracking
such metrics will ultimately help an organization re-align their
resources as needed and put projects on hold, cancel them or
spin up new ones based on these changes.

Potential PPfM Architecture

From an architectural perspective, we are starting to blur the
lines between how we budget projects (Finance), define
business needs (Senior Management) and run projects (Project
Managers, Project teams, etc.)

As we move toward a fully integrated Financial, Portfolio and
Program Management space, we will need to align our
organizations successfully and ensure that Project, Program,
Portfolio and Budgeting processes fall into a common working
framework.  This is not a simple undertaking, but the benefits
of selecting the right projects and enabling teams to manage
work efficiently on projects they know are important will truly
begin to drive a projectized organization.

Continued from page five

Portfolio Management System

Figure 3: By organizing a group of projects, they will naturally fit into the
appropriate programs, which provide a higher-level view of work being

run to meet one primary goal or deliverable.

Figure 4: All projects are integrated to deliver on their program’s
objectives.  The programs roll up to a portfolio that defines your

organization’s overall business objectives. 
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Figure 5: A fully integrated perspective of a Financial, Portfolio, Program
and Project Management solution.
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Ask Brian

Ask Brian covers topics appearing in the Microsoft Office
Project Support Newsgroup, where people with questions about
Microsoft Office Project can interact and seek solutions.
Members can find this newsgroup and many more in the
Members Only Section, www.mympa.org/members.asp

Continued on page seven

ometimes, a task must start on a particular day of the
week. Such tasks might include upgrades requiring a
server outage, testing that can be done only when users

are not online, or tasks that have to be done on a Saturday or
Sunday. Unfortunately, if the task gets moved because of a delay
in a predecessor task, you’ve lost your chance to perform the
task on the specified weekday.

Microsoft Project provides ways to make sure that a task starts
on a particular date but not on a given day of the week. This is
a perfect example of how you can use VBA to add functionality
to Project. This article will look at a macro that lets you specify
a day of the week for a task to begin. When run, this macro will
make sure that the task starts on that day of the week.

How it works
This macro requires you to use the Text1 custom field. For each
task that must start on a given day of the week, you enter that
day in this field. For example, the task in Figure A needs to start
on Monday, which is reflected by the contents of the Text1 field.

S
Using VBA to tie a Project task start date to a certain day of the week

Brian Kennemer, www.projectified.com ...endlessly obssessing about Microsoft Project so that you don’t have to.

The downside to this technique is that it runs the macro often,
so if your project is large, Project may run slowly. You’ll want to
select an approach that’s tailored to a particular project and
based on how often you think the macro will need to be run.

Continued on page seven

You enter the required weekday in the Text1 field.

When you run the macro, it sends the start date of each task
whose Text1 field contains any text through the Weekday VBA
function. This function returns the day of the week on which 
the given date  occurs. The macro then compares this value 
to the contents of the Text1 field. If they are the same, 
nothing happens. The macro moves to the next task. But if they
are different, the macro adds one day to the start date until 
they match.

The big thing to remember here, is that the day you enter into
the Text1 field for any of these tasks, must be marked as a
working day in the default calendar for the project. If the day
you enter is not a working day, the macro will return an error
message. Listing A shows our macro.

Running the macro
Next, you need to consider the timing: When should the macro
run? You have a few options.

The easiest but least safe approach is to run the macro when you
know your tasks have moved—or you think they might have.
This is just a matter of running the macro manually, but it’s
somewhat risky because it relies on you to remember to run it.

The next option is to run the macro every time the project
changes or is calculated. You can do this by inserting a call to the
macro in the project’s Change (or Calculate) event. Figure B
shows the Change and Calculate events for this Project object
with the code to call the macro.

Seize the day…of the week
There’s no reason for your project schedule to suffer because you
missed a window for some type of critical testing or upgrade.
Use this macro to link those tasks to a specific day of the week.
That will be one more thing the system can manage and one less
thing for you to worry about.

Listing A: Day of week macro

Sub SetDayofWeekStart()
Dim T As Task
Dim D As Date
On Error GoTo ErrorHandler

For Each T In ActiveProject.Tasks
‘Only check the tasks that contain text in the Text1 field
If T.Text1 <> “” Then

‘Ensure the contents of the Text field are in the right
‘case. The contents need to be first letter capitalized
‘and the rest of the text in lower case
T.Text1 = StrConv(T.Text1, 3)

‘Store the original value of Task Start date so that it can
‘be rest in case of an error
D = T.Start

‘Depending upon the contents of the Text1 field run
‘code that moves the tasks to the specified date
Select Case T.Text1

Calling the macro via a project’s Calculate and Change events

Figure A

Figure B



7

Continued from page six

Case “Sunday”
Do Until Weekday(T.Start) = 1

T.Start = T.Start + 1
Loop

Case “Monday”
Do Until Weekday(T.Start) = 2

T.Start = T.Start + 1
Loop

Case “Tuesday”
Do Until Weekday(T.Start) = 3

T.Start = T.Start + 1
Loop

Case “Wednesday”
Do Until Weekday(T.Start) = 4

T.Start = T.Start + 1
Loop

Case “Thursday”
Do Until Weekday(T.Start) = 5

T.Start = T.Start + 1
Loop

Case “Friday”
Do Until Weekday(T.Start) = 6

T.Start = T.Start + 1
Loop

Case “Saturday”
Do Until Weekday(T.Start) = 7

T.Start = T.Start + 1
Loop

End Select
End If

Next T
Exit Sub
ErrorHandler:

‘Error 1101 is raised when the specified day is a non working day
‘This causes the macro to add so many days to the start that it hits
‘the upper limit of Project dates (year 2049) This error code will
‘pop a message box and reset the start Date back to what it was
when ‘the macro got to that task.
If Err.Number = 1101 Then

MsgBox Prompt:=”Task: “ & T.ID & “ Contains a Day that is a
nonworking Day”, _

Buttons:=vbCritical, Title:=”Day of Week Set Macro Error”

T.Start = D
Else

MsgBox Prompt:=”Error Number: “ & Err.Number,
Buttons:=vbCritical, _

Title:=”Day of Week Set Macro Error”
T.Start = D

End If

‘The Weekday function can return any of these values:
‘
‘Constant Value Description
‘
‘vbSunday 1 Sunday
‘vbMonday 2 Monday
‘vbTuesday 3 Tuesday
‘vbWednesday 4 Wednesday
‘vbThursday 5 Thursday
‘vbFriday 6 Friday
‘vbSaturday 7 Saturday
End Sub
©TechRepublic 2005. Reprinted with permission from TechRepublic.
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IT Staff Resource Capacity Planning Using Microsoft's Project Server – Part III
Bill Ferro, MS, PMP, The Cincinnati Insurance Companies (Member, Greater Cincinnati Chapter)

n our earlier discussions of IT resource management,
concepts were proposed which introduced work type
classifications for application through use of Microsoft’s

Project Server.  (See The Project Network, Volume 9 Issue 3 –
2005, and Volume 10 Issue 1 – 2006, page 8).  Work Class,
Work Type and the Chart of Work, are structures that may be
defined to facilitate IT staff planning with the goals of forecasting
future work demand and reporting on the ability to take on new
work.  While some of the benefits of implementing this process
were discussed and a few reporting examples were given, this
discussion will highlight additional reporting features available
through Project Server in support of IT resource management.
It is recommended, in order to appreciate the following
discussion, that the reader review the previous articles on this
subject as noted above.  

Having defined the high-level Work Classes as Class 1 –
Operational, Class 2 – Tactical and Class 3 – Strategic;
constructed the Chart of Work schedules; and implemented
timesheet reporting throughout the IT organization, certain
native features of Project Server can be used for effective
periodic reporting.  The various levels of IT management will
typically have different needs and interests for viewing the
resource management data.  The Resource Center and Portfolio
Analyzer features of Project Server can be used to provide this
pertinent reporting.  

Resource Center Reporting

Line level resource managers may be interested in viewing a
detailed level of resource management data.  The Actual time
posted to the different Work Classes and Work Categories may
provide valuable insight into the delivery of customer requests
and performance of the particular organizational department.
The most fundamental report is possibly a historical timesheet
view.  Through the facilities of the Project Server Resource
Center, timesheet data can be sorted and viewed by individual
Resource and the Work Classes.  Through simple manipulation
of the filtering capability available in the Resource Center,
similar views can be generated which sort by Project, Task and
Resource.  See Figure 1 for an example (note that the data has
been loaded to MS Excel, simply for ease of printing).  

Resource Assignments - John Q. Smith
April 15 through April 21, 2006

In addition, the View Availability function can be used to
demonstrate the past, immediate future and longer range
planned allocation of individuals or logical groupings of
resources.  An example of this is shown in Figure 2.  

Continued on page nine

As noted previously, this type of data and reporting can be 
useful in preparing status reports, tracking progress on work
requests and initiatives, and justifying additional headcount or 
re-aligning available resources.  

I

Figure 1:  Sample Resource Center Timesheet View

Figure 2:  Resource Availability Report Example

Portfolio Analyzer Reporting

The Portfolio Analyzer features of Project Server make use of
Analysis Services and OLAP reporting.  This potent reporting
facility enables Resource Management reporting useful to all
levels of management.  While the OLAP cube may be extended
through programming and use of macros, and SQL Server
Reporting Services may provide increased capability for report
formatting and distribution, the standard functionality can be
used to produce some very robust planning and management
reporting.  Some of this capability will be displayed here.  

The Percent of Available Time Recorded can be tracked as a
measure indicating the efficiency of time entry for the various IT
groups.  This is calculated by dividing the estimate of time
entered in a work interval by the available time in the same
interval.  Figure 3, below, provides an example.  This measure is
a basic analytic measurement of effectiveness and completeness
of the Resource Management process.  

Figure 3:  Percent of Available Time Entered

Continued on page nine
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Continued from page eight

By reporting on Work Type, the amount of actual work
performed in a given timeframe can be displayed by Work Class.
This is useful in understanding where the IT organization is
applying its efforts.  The entire organization may be analyzed in
this way, or the various departments may be isolated.  See Figure
4.  This type of graph may also be useful for displaying work
performed by different resource types.  

Actual performance of the IT organization may also be
compared to the planned or budgeted time.  This can also be
analyzed by pertinent time intervals, such as monthly or
quarterly.  Figure 5 depicts this type of view.  This report 
may also be constructed to show further sub-categories of 
Work Type.  

Figure 4:  Percent of Effort Report Example

Resource capacity projections and capability to forecast resource
availability to perform new work will depend upon effective
time reporting by all departments.  Accurate and complete time
reporting is the fundamental necessity to ensure realistic
analyses.  The graph in Figure 6 displays the remaining quarters
of 2006 and calculates the residual availability of IT resources.

Figure 5:  Actual Performance Compared With Planned Performance

Continued on page ten
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By further applying the data from the existing project and Work
Type schedules, calculations of work already scheduled for
future completion is shown.  The difference between the
projected availability and remaining work represents the time
available to be scheduled for new work.  Negative values
indicate projected over-allocation, while a positive value
specifies time available for new work.  

filtering of data to display specific resource types, special projects
and Work Types.  

Summary 

Resource capacity planning practices may be effectively applied in
order to meet the demand for work imposed upon the IT
organization.  Budgeting of resources for planned project funding
can be analyzed and tracked over time for successful management
of work expectations.  The reporting analyses discussed in this
article demonstrate examples of how the resource management
practices may be applied.  This is just a suggested starting point.
By applying creativity and working with IT management to devise
new reports, the practice may be extended.  Topics for future
discussions in this series will address business plan alignment and
application with IT resource management.  

Continued from page nine

Resource Planning

Figure 6:  Projected Resource Availability

Figure 7 presents a view of the time available for new work in
the remaining quarters of 2006.  This information is shown for
the entire IT organization, but it can easily be decomposed to
present a graphical view by the individual departments.  

Many variations of these report and graph types can be produced
using the Portfolio Analyzer.  Some suggested examples include

Figure 7:  Projected Resource Capacity
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Dynamic Scheduling with Microsoft Office Project 2003
Eric Uyttewaal, PMP, President, ProjectPro Corp. (Member, Ottawa Chapter)

The Principle of Dynamic Scheduling

ynamic Scheduling is not just a fashionable term; it has
some substance to it. The principle of Dynamic
Scheduling is that, ideally, when one thing changes in

your real life project, you would have to change only one cell in
your Microsoft Project schedule to have valid and accurate
forecasts again for all tasks. With a dynamic schedule, your
schedule is easy to maintain and you will be able to keep your
schedule alive during the busy project execution. A schedule is
only dynamic enough if the schedule can easily be kept up-to-
date when you are very busy during project execution. Think of
a schedule as a dynamic model that you keep up-to-date
continuously until the project is over. 

You will only come close to this ideal if you set your schedule up
in the right way. A schedule is only a dynamic schedule if it
meets the following requirements: 

• You treat dependencies as cause-and-effect relationships
rather than as sequencing relationships. Many people use
the feature of dependencies to drive certain dates or
preferred task sequences into their schedule. These people
capture chronology with dependencies. The problem with
this is that the dates, sequences or chronology of tasks often
changes in a project. For example, if you set a dependency
between install software for team A and install software for
team B to make team A happen before B, things might
change that force you to reverse the dependency between A
and B. For example, team A might tell you they are not
ready that early. As a result of chronology dependencies, the
network often needs to be adjusted. If you capture instead
cause-and-effect relationships with dependencies in the
schedule, you don’t need to make changes to the
dependencies constantly. After all, finishing the walls causes
the roof construction to be able to start, which is true
before, during and after the project; it does not change.
Dependencies should reflect the practical necessary
relationships between tasks. Similarly for lags and leads;
they should reflect practically necessary gaps or overlaps.

• You find and enter all the cause-and-effect dependencies
between the tasks in the schedule that may impact your
forecasts. You need to carefully check if you have found and
entered all relationships. There are simple techniques
available to do this, but this article would be too long to
describe them.

• You minimize the number of hard dates in your schedule.
Hard dates are called schedule constraints in MS Project.
We don’t mean here that you cannot use constraints at all,
but each constraint needs to increase the validity of the
schedule, rather than only restricting the dynamic
scheduling of tasks. For example, adding a must-start-on

constraint to a task man the booth at the conference creates
a better schedule since the conference dates are fixed. On
the other hand, if you promised a document to the client on
July 13 and you add a finish-no-later-than July 13
constraint to the milestone document delivered, the
constraint does not add validity to the schedule, but simply
restricts MS Project in scheduling the task. Instead this
promised date should be modeled in MS Project by using a
deadline date rather than a constraint. Deadlines do not
restrict the scheduling unlike constraints.

The way the data is entered into Microsoft Project determines if
the resulting schedule is static or dynamic. If you enter only the
deliverables, the tasks, their estimates and the dependencies
between the tasks, you created a dynamic schedule. Perhaps you
need one or two constraints, but you have to be able to explain
how they make your schedule more valid.

How Does Dynamic Scheduling Help Me in
Scheduling My Project? 

Many changes occur in every project. Every time a change
happens, you need to change your schedule to reflect the new
reality. If you have hard-coded many dates in your schedule and
created a static model, you need to review the start and finish of
all future tasks every time you make a change in the schedule. If
you have captured other things than pure cause-and-effect
relationships with dependencies, you need to review many start
and finish dates as well. You have used features in a way that
restricts MS Project from doing its job. 

If you have a dynamic model, you typically need to revise only
one cell for each change that occurs. If you did an excellent job
on dependencies, you probably don’t even need to review the
future tasks and you can rely blindly on the network of
dependencies to adjust all future dates appropriately. That is
what I do in my projects; I enter the change and I look for any
red flags from missed deadlines. 

Cause-and-effect network logic stays the same during the entire
project. In other words, show restraint with constraints. And if you
do the logic well, your life will be swell. 

Will I Spend More Time on a Dynamic Schedule or
Less Time?

Let’s see if we can approximate how much time you have to
invest to make the model dynamic and how much time you will
gain when you apply the principle of dynamic scheduling.
Imagine a 3-month schedule with 100 tasks. It will take
approximately 8 hours of effort to discuss, identify and set 

Continued on page twelve
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all the dependencies and make the model of your project
entirely dynamic. 

How many changes will occur in the project? This is the hard
question. We do know for sure that each task needs to be
updated at least once, and about 30% of them twice. This
already results in 130 changes to the schedule, if you enter them
all individually. Apart from this, other changes typically happen
in projects: 

• Clients change their mind on requirements

• Deliverables are dropped; others are added 

• Activities that were overlooked are inserted 

• Activities that cannot be done are dropped

• Resources get sick or are reassigned

• Resources are interrupted with higher priorities (bug fixing,
trouble shooting, help desk calls)

Let’s be conservative and say that these other things cause 50
more changes, to a total of 180 changes for a 100 task schedule.
Entering 180 changes in a dynamic model would take you about
8 hours, since you only need to revise one (or two) cells for each
change. So, the total number of hours spent on a dynamic
schedule is 8 hours to create it and 8 hours to maintain it: 8 + 8
= 16 hours.

Entering 180 changes in a static model will require you to
review the rest of the schedule every time. Therefore, you have
to review and adjust on average the start and finish dates of 50
tasks in a static schedule with every change. If adjusting 50 tasks
takes you about 2 hours for each change, the total time spent to
keep the schedule alive will be 180 x 2 = 360 hours. Working
with a static schedule becomes a fulltime job and does not allow
project managers to help their team members any longer.

What you will see in practice therefore is that people who work
with static schedules get smart and don’t enter each change
immediately. Let’s say, they enter 5 changes at a time and only
then review the rest of their schedule. In other words, they
update their schedule only 180 / 5 = 36 times instead of 180
times. Notice that the schedule is not up-to-date all the time any
longer (up-to-date in real-time). Even in this case, they will
spend at least 36 x 2 = 72 hours on their schedule. We can
conclude that the difference in effort spent on a static schedule
versus a dynamic schedule is at least: 72 - 16 = 56 hours for
a 100 task schedule of 3 months duration, which is the gain you
can expect from applying the principle of dynamic scheduling.
This is time you will be spending with your family or friends
instead of with MS Project. Since there are about 56 business
days in a 3 month project, a dynamic schedule allows you, as the

Dynamic Scheduling
Continued from page eleven

Continued on page thirteen
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project manager, to go home one hour earlier every day of the
project if you apply dynamic scheduling.

What Are All Expected Gains from Dynamic
Scheduling?

The expected gains from applying the principle of dynamic
scheduling are:

• You save 56 hours of scheduling effort on a 100-task, 3-
month project. The projects in your organization are
probably different in size than the project I described. You
can look at your average project duration and average
number of tasks per project. You can then calculate the
hours saved per schedule in a similar way as I did. Multiply
this by the number of projects your organization has, and
you will get an idea about the potential for savings.

• It is easier to develop what-if scenarios with a dynamic
model than with a static model. Every time an unexpected
event happens, you will have to develop several what-if
scenarios to find a solution for a slippage or another issue.
The dynamic model will allow you to find a favorable
scenario much quicker than a static model. 

• Dependencies allow you to manage proactively.  You set
dependencies during the planning phase of the project
(when you have time) and then you reap the benefits of
them during the execution phase (when you don’t have
time). If you use hard dates to schedule, it is the other way
around; you will spend less time entering dates during the
planning phase (when you have time) and you will spend
more time keeping the dates right during the execution
phase of the project (when you don’t have time).
Dependencies help during execution, when hard dates are a
pain. Dependencies help you be proactive; hard dates will
make you reactive.

• A dynamic model can be up-to-date all the time.  If you also
use Project Server as a communication platform, executives
can see real-time status in their projects. Real-time status
removes the feedback loop in reporting. A feedback loop
causes a management delay in addressing issues. Long
feedback cycles are known to allow projects to spin out of
control (Systems Theory). You know this already because
when you drive on the freeway, you need 0.1 second to
slam the brakes. In 0.1 second you will still travel a certain
distance. If you drive closer to the car in front of you than
the distance you will travel, you will hit the car in front of
you, for sure. The longer the feedback loop, the less control
you have.

Let’s create better schedules by treating them as dynamic 
and valid models of our projects.  If you want further
information on dynamic scheduling, please refer to the 
book “Dynamic Scheduling with Microsoft Office Project 2003”.
For more information, contact Eric Uyttewaal at
EricU@ProjectProCorp.com.

©International Institute for Learning, Inc.

Dynamic Scheduling
Continued from page twelve



14

xperienced project managers know that a project
schedule is only as good as what goes into it.  Without
timely updates and attention to detail, a schedule can

quickly deteriorate into an obsolete shell of the real-world project.

In the same way, what comes out of a project is just as
important. Collaboration and decision-making will be impaired
across the entire team if managers and stakeholders cannot get
the interactive charts and reports they need to understand and
communicate key information about project status, costs,
performance, and resources.

The Visual Display of Project Information
John Garay, VP and COO, DecisionEdge, Inc. (Member, Philadelphia-Delaware Chapter) 

E 3) Schedule Status – Status charts and reports help you
answer questions such as “How does this project compare
to baseline?” and “Are we completing milestones on time?”
Gantt and milestone status charts visually display schedule
status, while status reports provide this key information in
tabular format.

4) Performance – Adding earned value charts and reports can
significantly improve your project control efforts.  For a
complete view of project performance, the excellent
Australian Standard 4817 (AS 4817-2006) specifies ten
project charts and reports for project performance
measurement using earned value.

5) Costs – If you cost-load schedules, you want cost charts
and reports to avoid shortages, compare against plan, and
efficiently allocate money across your projects. 

6) Combine and Compare Projects – Most organizations
have not one but many active projects. A charting and
reporting tool with multi-project capabilities provides a
holistic view of resources and costs and provides a way to
compare projects with each other.

7) Executive Communication – A picture that helps busy
executives quickly understand key project information is
worth more than a thousand words.  Dashboards, bubble
charts, and other high-level charts and reports provide
executive stakeholders with the information they need for
timely decisions.

8) Reporting in Specific Formats – Many organizations are
required to create and share project charts and reports in
specific formats.  A solution that provides a development
environment for custom charts and reports, or a solution
provider that can provide design services, will help managers
save the time and effort that would otherwise be spent
copying project data into spreadsheets for manipulation.

As a manager in a project-
centric organization, you
already invest significant
time and effort in your
schedules.  By adding a
charting and reporting
tool designed specifically
for Office Project, you can
also quickly and easily 
get the information you
need from your projects
so that everyone on your
team can make better
decisions.

As Daniel Queva, Senior Product Manager for Microsoft Office
Project, wrote in the last issue, raising the visibility and insight
into data that comes from using Office Project is a priority issue.
Microsoft is adding new tools and functionality in the next
version of Office Project for better reporting and analysis, a key
step forward in improving project collaboration.  At the same
time, Microsoft’s software partners such as Critical Tools,
DecisionEdge, and Kidasa, add value by providing solutions
focused on helping managers make better decisions with
enhanced project reports and graphics.

Adding complementary graphics and reporting software to
Office Project can immediately provide new insight into all your
projects.  This new perspective can uncover important issues
that might otherwise remain hidden until it is too late.

Focus on Key Project Areas and Functionality:

1) Resources – Interactive charts and reports that alert you 
to shortages in people, equipment, and material are critical.
Multi-project resource charts and reports can also help you
efficiently allocate resources across your entire project portfolio.

2) Structure – Understanding the basic structure of your
projects helps ensure a realistic schedule.  PERT and WBS
hierarchy charts visually display the structures of your
projects, while activity count charts show the number and
type of tasks scheduled across time periods.

Raise project visibility with charting and reporting solutions for Office Project

Keep executives informed 
with dashboards
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INTRODUCTION

oot-Tie-Camp is a loaded name and therefore requires explanation.  It arose as a mini Boot Camp (Boot-ee, get it?) version of
the first Enterprise version of the Microsoft Canada Official Project/Visio Boot Camp course I was asked to author and
instruct, and yes I wear a tie and love it when someone gets the “tie” joke.  By now you may have a feel for my students’

pain and punishment.  

The Cheat Sheet is a carrot seen to give gain without pain.  The top-left hand short-cuts were a big deal a decade ago or so, when I
created the Cheat Sheet.  Today Grade One children know those short-cuts and therefore you should know them – just ask my
Grade One kiddies.  In fact, use of the Project Specific Shortcuts (bottom left) will likely win the respect of small children, as I did
with mine.  They (shortcuts) also reduce carpal syndrome, while reducing errors, speeding things up, and making it easier to
transition into the world of legacy system integration through VBA programming (my next article).  That and you will look cool.

CHEAT SHEET - MICROSOFT PROJECT 2003 BOOT-TIE CAMP 
Non-abandonment skills to pave the way for EPM elevated PMOs 

David D’Silva, PMP, Intelligent Market Solutions Group Inc. (Interim President, Greater Toronto Area Chapter)

B

WINDOWS APP GENERIC SHORTCUTS
Ctrl+Home....................................................................Top Left
Shift+Arrows ....................................................................Select
Shift+Alt+Right/Left ........................................Demote/Promote
Ctrl+s ................................................Save Child Window (File)
Ctrl+o ..............................................................................Open 
Ctrl+w ..............................................................................Close
Alt+F4 ..................................................Close Parent (Program)
Alt+f ....................................................................................File
Ctrl+Space ..........................................................Select Column
Shift+Space ..............................................................Select Row
F5 ......................................................................................Goto
F2........................................................................................Edit
Ctrl+x ..................................................................................Cut
Ctrl+c ................................................................................Copy
Ctrl+v ................................................................................Paste
Ctrl+f..................................................................................Find
Ctrl+z................................................................................Undo
Ctrl+p ................................................................................Print
Ctrl+Esc..............................................................................Start

SEVEN ITERATIVE STEPS TO PROJECT HAPPINESS
1.  Create a Calendar (Tools -> Change Working Time)

2.  Create Resources (View -> Resource Sheet)

3.  Create Tasks & Link (Task1 to Task2 as FS)

4.  Assign Resources (Tools -> Resource Assignment)

5.  Save Baseline (Tools -> Tracking Baseline)

6.  Specify % Complete (Tools->Tracking Update Project)

7.  Create & Print Reports (View -> Reports)

WINPROJ SPECIFIC / COOL SHORTCUTS
Ctrl+F2 ..............................................................................Link
Ctrl+Shift+F2 ..................................................................Unlink
Ins ............................................................................Insert Row
Shift+Space, Del ......................................................Delete Row
Alt+Home/End ..................................................Gantt Start/End
Shift+F2 ......................................................................Task Info
Alt+F10..............................................................Insert Resource
Shift+F6 ..................................................................Split Screen
F6 ..............................................................................Next Pane

SEVEN SAMPLE DO’S AND DON’T’S
1.  Don’t hard code dates, use: Shift+F2 (Task Information)->Advanced->Constraint Types

2.  Beware of dragging and dropping and the failed double-click on the Gantt Chart side

3.  Beware of using multiple base lines unless you know what you are doing.

4.  Do realize MS Project is a tool best used with a methodology

5.  Do add WBS numbering: Tools->Options->Show outline number

6.  Do use shortcut keys to avoid accidental “What the heck just happened!?” (See #2)

7.  Do save (Ctrl+s) every time you hear yourself fret “My gosh, I hope I don’t lose this!”

Start->Run->winproj->Enter

© 2006 Intelligent Market Solutions Group Inc.
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